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USER GUIDE

SCC-D001 Isolated Digital Output
Module

The SCC-DOOL is a single-channel, optically isolated digital output
module. The output circuitry consists of a photomos relay and a load
resistor. You can use the SCC-DOO01 with a 5-24 VDC external voltage
supply to switch external devices such as transistors and solid-state relays.

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, see the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

This icon denotes a note, which alerts you to important information.

When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

> Pa B

When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select in software, such as menu
items and dialog box options. Bold text also denotes parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.
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monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 SC-2345 refers to both the SC-2345 connector block and the SC-2345 with
configurable connectors.

SCC SCC refers to any SCC Series signal-conditioning module.

What You Need to Get Started

To set up and use the SCC-DOO01, you need the following items:

a
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SC-2345/2350 with one of the following:

- SCC-PWRO1

—  SCC-PWRO02 and the PSO1 power supply

—  SCC-PWRO3 (requires a 7 to 42 VDC power supply, not included)

One or more SCC-DO01 modules

SC-2345/2350 User Manual, available at ni . com
SCC-DOOI1 Isolated Digital Output Module User Guide
SCC Quick Start Guide, available at ni . com

Read Me First: Safety and Radio-Frequency Interference
SC-2345 Quick Reference Label

68-pin E Series DAQ device, documentation, and 68-pin cable of less
than 2 m length

1/8 in. flathead screwdriver
Numbers 1 and 2 Phillips screwdrivers
Wire insulation strippers

NI-DAQ (current version) for Windows 2000/NT/XP/Me

@ Note The Macintosh operating system is not supported.
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Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2350 carrier, refer to the SCC Quick Start Guide, available
for download at ni.com/manuals.

Installing the Module

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

Plug the SCC-DOO0L into any digital input/output (P0.) socket J(X+9),
where X is O to 7, on the SC-2345. When you configure the SC-2345
according to the procedure in the SCC Quick Start Guide, the SC-2345
routes the output signal from digital line PO.(X) on the E Series DAQ

device.
Connecting Loads to the SCC-D001
@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg to

confirm the signal names.

Figure 1 and Figure 2 show two ways to connect a load and an external
voltage supply to the SCC-DOO01. These configurations have different
electrical characteristics, as described in the Specifications section.
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E Series SCC-DOO01
+5V
N
Status —
LED 66.5Q
12w 3 Vg
1

— 16 Q

PO.(X) l
Power-Up los
State Switch o) 2
) _l_— RLOAD1
— |1 Veom

u|

-=a

777 = External voltage source may be floating or ground-referenced.

5-24 VDC

Figure 1. Connecting a Load R gap1 t0 Veom and Vgyr (Configuration 1)

Figure 1 shows Configuration 1, with aload R g5p; connected to the Vom
and Vgyr terminals and a voltage supply connected to the Vgg and Vgum
terminals. Connect Configuration 1 to the SCC-DOO01 by completing the

following steps:

1.  Remove all power from the signal lines.

2. Strip 7 mm (0.27 in.) of insulation from the ends of the signal wires.

3. Insert the wires into the screw terminals.

a. Connect the negative lead of the voltage supply and the negative
lead from R} gap; to screw terminal 1, Vo

b. Connect the positive lead from Rj gap; to screw terminal 2, Voyr.

c. Connect the positive lead of the voltage supply to screw

terminal 1, Vgg.

4. Tighten the screws to 0.5 to 0.6 N - m (4.4 to 5.3 Ib - in.) of torque.
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Figure 2. Connecting a Load R gap» t0 Vour and Vgg (Configuration 2)

Figure 2 shows Configuration 2, with a load Ry gsp, connected to the Vqyr
and Vgg terminals and a voltage supply connected to the Vgy and Vgg
terminals. Connect Configuration 2 to the SCC-DOO01 by completing the
following steps:

1. Remove all power from the signal lines.
2. Strip 7 mm (0.27 in.) of insulation from the ends of the signal wires.
3. Insert the wires into the screw terminals.

a. Connect the negative lead of the voltage supply to screw
terminal 1, Vo

b. Connect the negative lead from Ry gap, to screw terminal 2, Vo

c. Connect the positive lead of the voltage supply and the positive
lead from R gap, to screw terminal 1, Vgg.

4. Tighten the screws to 0.5 to 0.6 N - m (4.4 to 5.3 b - in.) of torque.

For information about configuring the SCC-DO01 module using
NI-DAQmzx, refer to the SCC Quick Start Guide.
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Specifications

These specifications are typical at 25 °C unless otherwise stated.

Output Characteristics

Compatibility .......ccceeeeereerieneriereeieee TTL-compatible
Number of channels..........cccceceeveninnnee 1
Supply voltage range ...........ccceceeeevenneee 5to024 VDC

Digital logic levels
Configuration 1 (refer to Figure 1)

Output Voltage Level
Logic Level between Vgoyt and Vcom
Low (Ip; =0 mA) ov
High (Ip; =25 mA) 22 VDC at Vgg=24 V

3VDCat Vgg=5V

Configuration 2 (refer to Figure 2)

Output Voltage Level
Logic Level between Vqyr and Veom
Low (Ip, =25 mA) 04V
ngh (102 =0 mA) VSS
Maximum continuous load current (/)
Configuration L........ccceeveveevencnnne. 86 mA
Configuration 2..........cccceeeeveneenenne. 120 mA
Minimum load resistance (at Vgg =24 V)
RIOAD] veeveeevenemrenieeeneiereeeenaeaee 196 Q
RLOAD2 .............................................. 184 Q
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Figure 3. Load Current versus Output Voltage, Configuration 1
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Figure 4. Load Current versus Output Voltage, Configuration 2

Propagation delay

Low to high......cccooveveviiiicccene 400 s typ!

High to 1oW .coovvieiiicicicceveee 300 us typ!
RiSE tiME ...oovveviieiirieiinieceeceeeee, 120 us typ
Fall time .....coovvieiiiiieiecceececee e 25 us typ

' The switching characteristics (turn-on time, switching time, and turn-off time) of the optical isolator used on the board limit
the data transfer rate.
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Power Requirement
Digital POWET ....cceovveneriiiiniiienicicnee 69 mW max

Physical Characteristics

DImenSions ........ccceevevevieeeieieiiniriireeeeeeens 8.89cm x2.92 cm x 1.85 cm
(3.50in. x 1.15 in. X 0.73 in.)

MASS .ottt 28.6 g (1.0 02)

I/O cONNECtOrS.....cevveeiierieeieeieeeieeieene One 20-pin right-angle
male connector;
one 2-pin screw terminal

Field-wiring diameter .............ccccccecuenee 28to 16 AWG

Maximum Working Voltage

Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Channel to earth...........cccceniriininnennne 42 V, Installation Category 2
Module to module.........cocceeveeeniinnennncnnne 42 V, Installation Category 2
Environmental
Operating temperature .............ccocveeveenne 0to 50 °C
Storage temperature..............ccoeeeeeuennnens —20to 70 °C
Humidity ....ooveeveniiiiniiiiinieicnicicee 10 to 90% RH, noncondensing
Maximum altitude.............ooovvvveviinnnnnnnnne 2,000 m
Pollution Degree (indoor use only) ........ 2
Safety

The SCC-DOO01 meets the requirements of the following standards
for safety and electrical equipment for measurement, control, and
laboratory use:

 IEC61010-1, EN 61010-15
« UL3111-1, UL 6101B-1
« CAN/CSA C22.2 No. 1010.1
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E Note For UL and other safety certifications, refer to the product label, or visit
ni.com/hardref.nsf, search by the model number or product line, and click
the appropriate link in the Certification column.

Electromagnetic Compatibility

EmiSSIONS ...cooovvveeieiiiieeeeeceieeee e EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMMUNILY oo EN 61326:1997 + A2:2001,
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

E Note For full EMC compliance, operate this device with shielded cabling. In addition,
all covers and filler panels must be installed.

CE Compliance
This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety) ............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMC) ...cccoeveeirininenenennenn 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/hardref.nsf, search by model number or product line, and click the
appropriate link in the Certification column.
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Figure 5 shows the I/O connector on the bottom of the SCC-DOO01.

/@

0000000000
0,0 0000000 0%+
1 Pin1 2 Pin2 3 PWB Key 4 Pin19 5 Pin 20

Figure 5. SCC Module Bottom View

Table 1 lists the signal connection corresponding to each pin. GND is the

reference for the +5 V supply.

Table 1. SCC-D0O01 Pin Signal Connections

Pin Number Signal
1 —
2 —
3 —
4 —
5 —
6 —
7 PO.(X)
8 —
9 +5V
10 GND
11 —
12 —
13 —
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Table 1. SCC-DOO01 Pin Signal Connections (Continued)

Pin Number Signal

14 —

15 —

16 —

17 —

18 —

19 —

20 —

Theory of Operation

Setting the Power-Up State of the SCC-D001

Status LED

Circuit Protection

The switch for setting the power-up state of the SCC-DOO01 is on the top of
the module. Switch it to High or Low depending on whether you want the
output state to be high or low on power-up. The switch does not override
the output state as determined by the E Series DAQ device.

The SCC-DOO0L1 has a status LED that indicates when an input signal
registers a logic high or a logic low. The LED is located above the screw
terminals. If the LED is off, the input signal is registering a logic low on the
digital line.

Protection Against Spike Voltages

Two clamping diodes protect the SCC-DOO01 against spike voltages caused
by inductive loads and long circuit wires. One diode is connected across
Vs and Vqyt and the other diode is connected across Vgout and Vo

© National Instruments Corporation 11 SCC-DO01 Isolated Digital Output Module User Guide



Signal Isolation

The Vcom, Vss, and Vgur signals on each SCC-DOO0L1 are isolated from
other channels and from the SCC-DOO01 internal power and ground signals.
The isolation barrier protects the SCC-DOO01 and other equipment from
voltages up to +42 VDC. Common-mode voltages higher than +42 VDC
can damage the SCC-DOO01 and other equipment.

National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of National Instruments

Corporation. Product and company names mentioned herein are trademarks or trade names of their

respective companies. For patents covering National Instruments products, refer to the appropriate

location: Help»Patents in your software, the patents. txt file onyour CD, orni . com/patents. 371077B-01 Mar04

© 2002-2004 National Instruments Corp. All rights reserved.
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